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1 Overview  

 

SiLENSe (Simulator of Light Emitters based on Nitride Semiconductors) is a specialized 

software tool for modeling the characteristics of light emitting diodes (LEDs) made of wurtzite 

semiconductor materials. The software allows simulation of an LED band diagram as a 

function of bias, electron and hole transport inside the structure, radiative and non-radiative 

carrier recombination, light emission efficiency, electric field distribution, and emission 

spectra from the LED. The software implements a one-dimensional drift-diffusion model with 

account for specific features of the nitride materials – strong piezoeffect, existence of 

spontaneous electric polarization, low efficiency of acceptor activation, and high threading 

dislocation density  in the structure. The software enables the analysis of graded-

composition heterostructures, which is important for designing LED structures of a new 

generation on the basis of bandgap engineering principles. 

 

Laser Edition of the package also enables computation of the waveguide modes and 

prediction of the threshold characteristics. 

 

Advanced numerical algorithms are employed in the solver in order to make the software 

more effective and robust. In particular, the mixed finite-elements method is implemented in 

the program to solve the nonlinear carrier transport equations coupled with the Poisson 

equation for the electric potential in a complex multilayer LED structure.  

 

The code has an easy-to-learn graphical user interface (hereafter, referred to as the shell) 

assisting the user in preparation of the input data, carrying out simulations, and results 

visualization. All the results can also be exported in ASCII files and explored within an 

external visualizer like Microcal Origin®, Tecplot®, Golden Software Grapher®, etc.  

 

1.1 SiLENSe Options 

The current version of SiLENSe package provides the user with the following options: 

� Calculation of the band diagram, current, internal quantum efficiency etc. for a given 

bias. One can also set up series computations to cover some range of the bias 

variation. 
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� Calculation of the carrier wave functions, and the emission and gain spectra from the 

known band diagram. 

� Plot an integral characteristics of the LED operation for all the computed biases, such 

as I-V curves etc. 

 

The following options are available in Laser Edition only: 

� Computation and visualization of the waveguide mode intensity distribution for both 

TE and TM polarizations with account for the birefringence in wurtzite crystals. 

Computation of the optical confinement factors. 

� Analysis of the laser diode operation for selected waveguide mode: 

1. Optical gain. 

2. Optical losses caused by the free carrier absorption. 

3. Threshold current and differential quantum efficiency. 

2 Installation and Registration 

2.1 Installation  

To install the SiLENSe , run the installation executable file and follow the installer 

instructions. To uninstall the program, run the unins000.exe file in the program home 

directory or use the respective item in the Programs menu. 

NB The software should have write permission for its home directory! 

The software is supplied with license protection system based on dongle key (HASP) which 

is a small USB device. During installation, the user is prompted to install the dongle key 

driver. 

2.2 Single node license 

The user can install the program on several PCs (for example, on the desktop and notebook) 

and run the program on the PC where the dongle key is plugged in. The registration 

procedure is as follows: 

� Plug in the dongle key module. 

� Start the license manager (License.exe) located in the HASP folder of the 

SiLENSe home directory. One can also do it by Windows Start button. 

� Choose the Key config tab and press the Make Key button. The key containing the 

information about the plugged in dongle key will be generated. 

� Send the key generated to STR by e-mail simuled-support@str-soft.com . 
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� When the reply from STR is received, start the license manager and press Accept 

Key button. 

� Insert the received key from the clipboard. 

� Close the license manager. 

� Run SiLENSe.  

2.3 Corporate/department network license 

Corporate/department license allows the user to run the software on several 

computers within the local area network (LAN). The software may be installed on any 

computer of the network, but the maximum number of computers running the software 

simultaneously is limited by a certain number, e.g. 10, specified in the particular license 

agreement (quotation, purchase order, etc.). 

Hereafter, by the ‘server’ we will understand the computer where the USB dongle key 

(HASP) is plugged in. The user should install the dongle key driver on this PC. A special tool 

server.exe called below ‘license server’ to be running on the server computer. After 

start, the respective icon appears in the system tray. The pop-up menu allows one to restore 

the window and inspect the event log or the license server. The Change Port button allows 

the user choose the port number for communication between the software running on other 

PCs and the license server. 

To obtain/update the license, on need run the License.exe file on the server PC. 

Further procedure is similar to described in Sec. 2.2 . 

All the PCs running the SiLENSe software we will call ‘workstations’. Running the 

software on the server computer is also allowed. Installation of the software on the 

workstations is described in Sec. 2.1. The user need not install the dongle key driver on 

workstations. On the contrary, one should run the License.exe file, choose Server config 

tab, and specify the IP address of the server PC and the port number. The Store button 

saves this information in the Str_Config.cfg file in the WINDOWS directory. This file is 

used by the software to communicate with the license server. The Remove button clears the 

file. The Test button allows one to test the communication with the license server. 

NB   The following conditions to be fulfilled for running the software on a certain workstation: 

(i) the dongle key to be plugged into the server PC, (ii) license server to be running on the 

server PC, and (iii) the workstation is able to communicate with the license server by the IP 

address and port number specified in the Str_Config.cfg file in the WINDOWS 

directory. 



 
 

 

    

SiLENSe User Manual 7 of 36 

 

NB Unplugging the dongle key from the server PC or stopping the license server will result in 

abnormal termination of all the running software copies!  

2.4 Limitations of Free Demo Version 

A free demo version of the SiLENSe software is available at STR web site www.str-soft.com. 

The demo version enables the user to evaluate the software. Demo version does not allow 

the user to run simulation of the band diagram and carrier transport. The user can only learn 

the interface and work with sample project files supplied by STR. Some of them contain pre-

computed results. 

3 Getting Started  

SiLENSe project files have *.sls extension and store the following information:  

� LED heterostructure 

� Global physical and solver parameters 

� Properties of the materials used in the heterostructure 

� Simulation results  

 

Warning: The package is designed in such a way that all the simulation results stored in the 

project file are always self-consistent with the input data. So the user can not modify the 

heterostructure and some global parameters like the temperature if there are some results 

stored (see description of the Tools->Unlock Project menu item).  

3.1 Materials Properties 

There is a special Properties Editor in the SiLENSe package for editing the materials 

properties. It provides a unified way to set up the material properties of binary semiconductor 

compounds and their alloys. The properties of the contact and insulating materials are also 

can be stored. The input data are saved in the special project file of the Properties Editor. 

All the computational modules of the SiLENSe package load material properties from these 

files. The detailed description of the Properties Editor is given in [1]. Below we give a short 

description of the Properties Editor in respect to the SiLENSe. 

 

Generally, the materials in the Properties Editor are divided into two types:  

� semiconductor alloys like AlInGaN, ZnMgO, AlGaAs, AlInGaP, etc.  

� all other materials of fixed chemical composition and structural modification.  
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Below we will call them “non-alloy” materials. The default database of the material properties 

is supplied with the SiLENSe package, but the user can add new materials as well as modify 

the properties of the existing ones. 

 

Creating a new SiLENSe project file, one should specify the Properties Editor project file 

from which the material properties will be loaded. The SiLENSe project file can include the 

layers made of the described materials and alloys. In the Material properties tab window, the 

loaded values are shown in the read-only mode. Justification of the choice of the materials 

constants used in the SiLENSe by default is given in [2]. 

3.2 Heterostructure  

A LED heterostructure is described as a sequence of layers. The user should specify the 

composition, doping and thickness of each layer. The growth direction is assumed to go from 

the first layer to the last one. However, this assumption does not limit the software capability 

because the user can choose the appropriate crystal orientation in the Heterostructure tab 

window. 

NB: The first layer appearing in the ‘Heterostructure’ list is thick n-type contact layer (usually 

GaN). The user need not input nucleation and buffer layers! 

3.3 Global Parameters  

In the Global parameters tab window, the user can specify some global physical parameters, 

such as LED operating temperature and some internal solver parameters controlling the 

numerical computations. The parameters related to analysis of laser diodes are shown in the 

Laser parameters tab window. A default set of the parameters is loaded automatically in a 

new project. The solver parameters are discussed in details in Sec. 5.6. 

3.4 Running the Calculations 

Most of the calculations can be started from the Run menu. Some of the Run menu items 

are duplicated by the respective buttons in the toolbar and/or hot keys. The menu item ‘Stop’ 

allows the user to abort current calculation. The calculation of the emission spectrum and I-V 

curve to be started from the List of Results window. One can open it by the Window | List of 

Results menu item or by the respective button in the toolbar. 
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3.4.1 Band Diagram and Carrier Fluxes 

To start single calculation of the LED band diagram, use the Single Calculation menu item. 

The modal window appears where you will be prompted to enter the bias and start the 

computations. The Calculation window appears where the iterative solution process is 

described. The user can abort the computations by the Stop button. When the calculations 

are complete, the simulation results are shown in the Results tab window containing several 

plots. To switch between the plots, use the vertical tabs along the left side of the plots. 

 

Series calculation menu item allows calculations for a number of bias values at once. The 

modal window appears with the list of biases which will be processed. The user can add a 

single bias by the Add button, while the Add sequence button enables one to add a 

sequence of biases varying from a Start bias to the End bias with a given Number of 

intervals. The entered biases can be edited or deleted by the buttons Edit and Delete, 

respectively. Use the button Delete All to clear the list. 

 

Series calculation for SpeCLED menu item allows automatic computations for a given range 

of the p-n junction bias and the temperature. List of biases is specified exactly as for series 

calculations, and the temperature list is specified in a similar way. 

3.4.2 Carrier Wave Functions, and Emission and Gain Spectra 

The carrier wave functions, and the emission and gain spectra are calculated from the 

already known band diagram. To start the calculation, one should open the List of Results 

window, select the desired bias, and use the Run | Wave functions and spectrum menu item 

or the respective button. The results are displayed in the Spectrum tab window containing 

two tabs with plots, Band diagram and wave function and Spectrum. 

 

The list of individual quantum wells appears on the right of the former plot. An individual 

quantum well can be selected in the graph by the vertical cyan stripe initially located in the 

first quantum well. This stripe can be moved from one well to another either by choice of the 

well number with the mouse in the quantum well list or by pressing the keys “→”, “←”, “↑”, 

and “↓” on the keyboard.  

 

The list of the localized state energies of the carrier in the selected quantum well is given in 

the mini-windows on the right of the quantum wells list. To show/hide the wave functions in 
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the main graph, use the check boxes in the mini-windows Electrons, Heavy holes, Light 

holes, and Split-off holes, where the energies of the respective energy states are indicated.  

 

The Spectrum plot shows the emission and gain spectra of individual quantum wells, as well 

as the total spectra. The user can switch the values of X-axis between the quant energy and 

the wavelength by the respective tab. 

 

3.4.3 I-V Characteristic and Internal Quantum Efficiency 

To get the I-V curve, one should open the List of Results window, select the desired biases, 

and use the Show | I-V Characteristic menu item or the respective button. The modal 

window appears with three plots. The former two plots represent the current density as a 

function of the bias and the internal quantum efficiency variation with the current density, 

respectively. The last plot is introduced to rely the calculated current density with 

experimentally observed I-V characteristics by qualitative accounting for the series and 

contact resistance. The user is prompted to specify the LED area, the series resistance, and 

the contact resistance for the n- and p-contacts. The current and voltage are calculated as 

described in Sec. 7 of [3]. 

3.4.4 Waveguide Modes 

To compute the electric/magnetic filed distribution of the waveguide modes, use the Run | 

Waveguide Modes menu item. The modal window appears where you will be prompted to 

enter the light wavelength. When calculations are complete, the results are shown in the 

Waveguide tab window. 

3.4.5 Laser Characteristics 

To compute the threshold characteristics, select the desired polarization (TE/TM) and the 

mode index in the Laser parameters tab window, and use the Run | Laser Characteristics 

menu item. The program will seek for the threshold performing calculation of the gain and 

loss for each bias (the details are given in [3], Sec. ‘Laser Characteristics’). The user can 

see the computation progress in the progress bar and stop calculations by the Stop button. 

 

3.5 How to Load, Export, and Delete the Simulation Results 

The project file contains some simulation results related to the project. The Window | List of 

Results menu item or the respective button opens the List of Results window with the table 
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of the results which were stored in the project file or computed during the current session. 

The table includes an integral data like the bias, current, internal quantum efficiency etc. To 

load a result in the Results tab window, one should choose the result by single mouse click 

and use the Show | Current result menu item or the respective button. A double-click on the 

respective string has the same effect. One can use the Edit | Delete selected menu item or 

the respective button to delete results selected by the checkboxes in the left column. 

 

The Export menu allows one to save the current result or the I-V curve in an ASCII file. The 

output formats are described in details in Sec.5. 

 

3.5.1 Export Simulation Results to SpeCLED Module 

The user can export simulation results to the SpeCLED module for further 3D analysis of 

current spreading and temperature distribution in the LED chip. One should check simulation 

results in the List of Results window and use the Export to SpeCLED menu item or the 

respective button. An Export to SpeCLED modal window appears with list of selected 

voltages. The user should start computation of emission spectrum by the Run spectra 

button. The status of spectra computation is displayed in the table. When spectrum 

computations are completed one can finish export by the Export button. 

 

Warning: The data for SpeCLED module should cover the whole IV range. The voltage step 

should be not greater than 0.1 V for voltages higher than a turn-off voltage. For a minor 

current under low biases a larger step of ~0.5 V is acceptable. 

 

4 Graphical User Interface 

The chapter describes the user’s options available to control the data input, simulation of 

LED characteristics, and visualization of the simulation results within the Graphical User 

Interface (GUI). The SiLENSe is provided with the interactive shell designed for easy-to-

learn specifying the input data, such as thickness, composition, and doping of each layer of 

a LED heterostructure, and for setting the computation parameters. The shell also provides 

an interactive control of computations as well as visualization of the results. The start 

window of the SiLENSe shell contains Menu, Toolbar and the title of the software tool in the 

center of the window.  
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4.1 Menu and Toolbar  

The Menu contains the File, Heterostructure, Material properties, Run, Export, Tools, 

Window, and Help items. The File menu allows one to create new project, open an existing 

project, save changes in the current project file, and exit the shell.  

 

Fig. 1. Load material properties to the new project. 

 

The menu item New is for creating new project. The modal window will appear where the 

user will be asked for the Properties Editor file with the material properties (3.1). The 

window also contains the lists of materials and alloys described in the selected file. The 

green tick and the red cross show if the respective item contains all the properties necessary 

for calculations. 

 

The Heterostructure menu contains different operation with the heterostructure layers. All 

these actions are duplicated y the respective buttons in the Heterostructure tab window. 

 

The Material properties menu allows the user to export the data from the current project to 

the separate material database file or overload the existent data from other SiLENSe project 

or material database file (import of the material properties). 

 

The Run | Single computation menu item starts single computation. The modal window 

appears where the user is prompted to input the bias. The Run | Series computations menu 

item allows one to perform a set of calculations for a number of bias values. The modal 

window appears with the list of biases which will be processed. The user can add a single 

bias by the Add button, while the Add sequence button enables one to add a sequence of 
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biases varying from the Start bias to the End bias with a given Number of intervals. The 

entered biases can be edited or deleted by the buttons Edit and Delete, respectively. Use 

the button Delete All to clear the list. 

    

Fig. 2. Series calculations modal window (left) and series calculation for SpeCLED (right). 

 

Series calculation for SpeCLED menu item allows automatic computations for a given range 

of the p-n junction bias and the temperature. List of biases is specified exactly as for series 

calculations, and the temperature list is specified in a similar way. Data for SpeCLED (*.sct 

files) are generated automatically, and SiLENSe files (*.sls) with complete results are 

optionally saved for all temperatures. 

 

During the computations, the bias values are indicated by colored rectangles. Grey color 

means that the calculation for the task has not been started, blue color marks the current 

task, successfully finished and failed tasks are shown by green and red colors, respectively.  

 

The Waveguide Modes and Laser Characteristics items of the Run menu allow one to start 

the computation of the waveguide modes and laser characteristics, respectively. 

 

The Stop item of the Run menu allows the user to abort current calculations. 

 

Some of the Run menu items are duplicated by the respective buttons in the toolbar and/or 

hot keys.  

 

NB The calculation of the emission spectrum and I-V curve to be started form the List of 

Results window. 
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The Export menu enables one to save computed result to ACSII file. The band diagram for a 

certain bias or the I-V curve to be exported from the List of Results window. Save current 

chart item allows the user to save current chart as a graphic file. 

 

The Tool | Unlock Project menu item and the respective button in the toolbar are enabled 

only if there are some results computed during the current session or previously saved in the 

project file. Then the user can not modify the heterostructure and global physical 

parameters. This limitation is introduced to make sure that the input data and the simulation 

results are self-consistent. Use this item or the respective button to delete all the results and 

enable modification of the heterostructure and global physical parameters. The confirmation 

dialog appears with warning that all results will be deleted. To keep the results, the user 

should (i) save the project to store the result obtained in the current session, (ii) save the 

project under a new name, and (iii) unlock the project and modify it. 

The Tool | View Iterations menu item and the respective button in the toolbar allow one to 

inspect the iterative solution process. When this option is turned on, the plots in the Results 

tab window are updated after each iteration. However, it makes computations slower. 

 

The Window menu is to open additional windows with solver log and auxiliary simulation 

results. The most important is the List of Results window containing a table of processed 

biases and some integral data like current density, internal quantum efficiency, etc. 

 

The Help menu includes the About option providing the user with brief information on the 

SiLENSe. 

 

The toolbar contains buttons for a quick access to the main options. 

 

4.2 Tabs of the Main Window 

4.2.1 Heterostructure  

The Heterostructure tab window allows the user to specify the LED heterostructure 

considered to be a sequence of semiconductor layers (Fig. 3). To manage layers, one can 

use the Heterostructure menu items or buttons from the vertical toolbar in the left part of the 

tab. Use Add Layer, Delete Layer, Edit Layer, Move Layer Up, and Move Layer Down to 

create, delete, and move the layers. One can copy the selected layer into a buffer and insert 
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the layer from the buffer after the selected layer by the buttons Copy Layer and Insert Layer, 

respectively.  

 

 

Fig. 3. Heterostructure tab window. 

 

When the user clicks the Add Layer button, the pop-up menu appears where the material 

type should be chosen from the lists of available materials and alloys. The Edit Layer button 

allows one to edit the layer properties (Fig. 4). The General properties section contains the 

name1, thickness, composition2, doping, and mobilities of electrons and holes. One may view 

the specified composition profile by using the Preview composition button. The additional 

properties are the electron and hole lifetimes related to the point defects, degree of the strain 

relaxation at the left interface of the layer, and dislocation density. Section ‘Composition 

fluctuations’ allows the user to input parameters related to Indium composition fluctuations in 

InGaN material. 

 

                                                

1  The layer name is not used by the code and introduced just for convenience. 

2  The composition is required only for layers made of alloys. 
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Fig. 4. Layer properties window. 

 

One should mark quantum well layers by the checkbox Active region in the Layer properties 

window. The marked quantum wells are indicated in the layer list by purple rows. Each 

“purple” region is treated as a separate QW.  

Warning: The user is responsible for adequate selection of the quantum wells. If the QW 

consists of several layers (for example, triangular or trapezoidal QW) , all the layers should 

be marked as QW. Generally, it is recommended not to mark barriers as Active region. 

However, one can include them to see the coupling between the QWs. The details are 

described in [3] in the section related to the spectrum calculation. 

NB: The 'Maximum number of levels in a QW' parameter shows the maximum number of the 

wave functions calculated. 

 

A Periodic structure button is introduced to simplify input of multiple quantum well structures. 

To create a periodic structure, one should select all layers in one period and use the Periodic 

structure button. The user is prompted to input a number of periods. When periodic structure 

is created, the number of periods is shown in the layer list, as seen in Fig. 3 for layers 5 and 

6. To delete the periodic structure, one should use the Periodic structure button and input 0 

or 1 period. The heterostructure may contain several periodic structures. Creating a new 

periodic structure overlapping with the existent ones will clear older periodic structures 

overlapping with a newly created one. 
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The Orientation combo box allows the user to specify the heterostructure orientation. Along 

with conventional [0001] orientation, a number of nonpolar and semipolar orientations are 

supported in the software. Respective inclination angle is shown below the combo box. 

Choosing "Custom Inclination Angle" in the combo box allows one to specify a custom 

inclination angle in [0,180] range. 

 

To calculate the piezoelectric field, one need to know the strain in the heterostructure. 

Unstarined (natural) lattice constants for each layer are calculated from the Vegard law, 

while actual strained lattice constant is calculated as follows. By default, first heterostructure 

layer is assumed to be relaxed (Relaxed first layer option in the Strain in the first layer 

section), i.e. having its natural lattice constants. To specify strain in the first layer, one can 

choose ‘Strained first layer’ option and manually specify the lattice constant for the first layer. 

Then lattice constant in the next layers is calculated according to the ‘degree of relaxation’ 

property of the layer. Zero relaxation means that layer has the same lattice constant as 

underlying layer, unity relaxation means that layer has its natural unstrained lattice constant. 

For details, see respective section on [3]. 

 

The bottom area of the Heterostructure window contains a plot representing variation of the 

following layer properties throughout the whole heterostructure: doping, mobility, degree of 

relaxation, dislocation density, lifetimes of recombination at point defects, and DOS tails. 

One can switch between the different variables by choosing the respective tabs. 

 

4.2.2 Global Parameters  

The Global parameters tab window (Fig. 5) represents the parameters applicable to the 

whole simulation and includes four subsections: Physical parameters, Main solver 

parameters, and Spectrum solver parameters. 

 

Physical parameters are the temperature and settings for the quantum potential model. One 

can switch it on/off as well as specify correction factors. Zero correction factor provide the 

same results as without quantum potential model. Temperature factors define the power law 

for temperature dependence of the radiative recombination constant and Auger 

recombination constants. 

 

Meaning of the solver parameters is described in detail in Sec. 5.6. 
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Fig. 5. Global parameters tab window. 

 

4.2.3 Material Properties 

The Material properties tab window shows the loaded materials properties in the read-only 

mode. The Material properties menu allows the user to export the data from the current 

project to the separate material database file or overload the existent data from other 

SiLENSe project or material database file (import of the material properties). The import can 

be done only if the new material database contains valid properties for all the materials used 

in the heterostructure. 
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Fig. 6. Material properties tab window. 

 

4.2.4 Results 

The Results tab window includes six plots designed in order to clearly present the simulation 

results: Band diagram, Potential & Electric field, Carrier concentration,  Recombination, and 

Current. Available manipulations with graphs are described in detail in Sec. 4.3.3. 
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Fig. 7. Results tab window. 

 

4.2.5 Spectrum  

The Spectrum tab window is divided into two tabs: Band diagram and wave functions and 

Spectrum. The former tab contains a plot with the band diagram and carrier wave functions 

as well as a list of the quantum wells. The quantum wells are numbered subsequently and 

their indices are listed in the subsection. The respective quantum well can be chosen by the 

mouse click and automatically marked by the cyan vertical stripe in the graph window. The 

movement from one well to another can be proceed either by direct choice of the well 

number by mouse or by the use of keyboard keys “→”, “←”, “↑”, and “↓”. 

 

The energy levels in the chosen quantum well are listed in the right subsection. The user can 

turn on/off the wave functions in the selected quantum well by the checkboxes near the 

energy values. The total number of the energy levels in the selected quantum well is given in 

the brackets after the carrier type. 

 

 

Fig. 8.  Band diagram and wave functions tab window. 

 

The Spectrum tab window shows the spontaneous emission and gain spectra of individual 

quantum wells, as well as the total spectra. The lines can be switched on/off by the 
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respective checkboxes in the right part of the window. The user can switch between the 

quant energy and the wavelength by the respective vertical tab. 

 

 

Fig. 9.  Spectrum tab window. 

 

4.2.6 Laser parameters tab window 

The Waveguide tab window contains global parameters related to the analysis of laser 

diodes. One group of parameters controls the calculation of the threshold characteristics. 

The user should specify the stripe geometry, reflectivity of the output and back mirrors, the 

polarization and index of the waveguide mode for which the analysis should be done. The 

Additional loss parameter allows one to specify an additional optical loss of any source. 

 

The other group of parameters controls computation of the waveguide modes. Since the 

electric/magnetic field distribution typically is much wider than the active region, for correct 

description of the waveguide one need to describe the thick n-contact layer and the 

substrate. The n-contact layer is assumed to be of the same composition as the first layer in 

the Heterostructure tab window, so one need only input its actual thickness. As for the 

substrate, the user should select the material from the drop-down list containing all the 

materials described in the project. The substrate composition field is enabled for alloy 

materials only. The Substrate thickness in computations parameter specifies the part of the 
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substrate included in the waveguide computations. It should just provide an exponential 

decay of the field distribution. Do not input here the actual substrate thickness! The Mesh 

step parameter shows the mesh step used in waveguide computations. 

 
Fig. 10.  Laser parameters tab window.  

 

4.2.7 Waveguide tab window 

The Waveguide tab window consists of two tabs: Refractive index waveguide modes and 

Far field. The former tab contains plot of the refractive index for ordinary (magenta line) and 

extraordinary (cyan line) waves (Fig. 11). The distribution of the electric and magnetic field 

intensity for TE and TM waveguide modes is shown by red and blue lines, respectively. The 

user can switch them on/off by the respective checkboxes in the right part of the window. 

The number appearing after the mode index is the effective refractive index β/k. The region 

of negative position represents the buffer layer and a part of the substrate. 

 The Far field tab shows the distribution of the far field intensity. 
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Fig. 11.  Refractive index waveguide modes tab window. 

 

Fig. 12.  Far field tab window. 
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4.3 Other Windows 

4.3.1 List of Results 

The Window | List of Results menu item opens the List of Results window with the table of 

the results which were stored in the project file or obtained during the current session. The 

table includes the following data: bias, current density (J), radiative (Jrad) , total non-radiative 

(Jnrad), Shockley-Read-Hall (JSRH), and Auger (JAuger) fractions of the current density, injected 

electron (Jn) and hole (Jp) current densities, minority carrier current densities (Jn right and Jp 

left),  internal quantum efficiency (IQE), IQE computed taking into account only light 

generated in the active region (IQE QW), injection efficiency, non-ideality factor (m), and 

peak emission wavelength (Peak WL). 

 

The menu bar of the List of Results window enables the user to manage the result 

computed. NB All the menu items are duplicated by the respective buttons in the toolbar. 

 

The Edit menu allows deleting selected results as well as select/unselect all the results. The 

user can load a result in the Results tab window by using Show | Current result menu item or 

just by double-click on the respective string in the table. To plot the current-voltage 

characteristics and internal quantum efficiency as a function of bias one should use the 

Show | I-V characteristic menu item. Only selected results will be evaluated. 

 

The item Run | Wave functions and spectrum enables one to calculate the carrier wave 

functions and emission spectrum for the current result (marked by the gray color). To 

calculate the peak emission wavelength for all results, one can use Run | Update Peak 

Wavelength menu item. 

 

The Export menu allows the user to export simulation result into a text file. First two items 

store the current result and I-V characteristic, respectively. Export | All Results in Single File 

menu item allows to export all the results for band diagrams, carrier concentration, and so on 

into a single text file for further analysis. The output formats are described in detail in Sec. 5.  
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Fig. 13. List of Results window. 

 

One can export simulation results to the SpeCLED module for further 3D analysis of current 

spreading and temperature distribution in the LED chip. One should check simulation results 

in the List of Results window and use the Export | Export to SpeCLED menu item. An Export 

to SpeCLED modal window appears with list of selected voltages. Prior to export one should 

start computation of emission spectrum by the Run spectra button. The status of spectra 

computation is displayed in the table. After the spectrum computation one can finish export 

by the Export button. 

 

Warning: The data for SpeCLED module should cover the whole IV range. The voltage step 

should be not greater than 0.1 V for voltages higher than a turn-off voltage. For a minor 

current under low biases a larger step of ~0.5 V is acceptable. 

4.3.2 I-V Characteristic 

The Show | I-V characteristic menu item in the List of Results window opens an I-V 

characteristic modal window with three plots. The former two plots represent the current 

density as a function of the bias and the internal quantum efficiency variation with the current 

density, respectively. The last plot is introduced to rely the calculated current density with 

experimentally observed I-V characteristics by qualitative accounting for the series and 

contact resistance. The user is prompted to specify the LED area, the series resistance, and 

the contact resistance for the n- and p-contacts. The current and voltage are calculated as 

described in Sec.7 of [3]. The plot is updated when one uses the Apply button. 
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Fig. 14. I-V characteristics modal window. 

 

4.3.3 Overlap Integrals 

This window shows the squared overlap integrals between each pair of the electron and hole 

wave functions. The data for different quantum wells are shown in different tabs. 

 

 

Fig. 15. Overlap Integrals window. 

 

4.3.4 Detailed Spectrum 

This window allows inspect fine details of the emission spectrum. Tree in the left part of the 

window shows total emission spectra and total contribution of each of the valence band 

followed by contribution of individual QWs. Contribution of each QW is also divide into 

contribution of three subbands and even individual transitions. Values after the colon 

indicate relative contribution of the item in the total emission spectrum. If the selected item 

represents parameters of an individual transition, the below table shows its following 

parameters: relative contribution to the total spectrum, squared overlap integral, occupancy 

factors of the electron and hole energy levels (at zero energy of the lateral motion), and a 

product of the squared integral and occupancy factors. 
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One can visualize the emission spectrum of an item by using button with right arrow or 

double click on the item. Then the item will appear in the check list in the center of the 

window. Check boxes allow show and hide individual lines. To remove an item from the 

check list, use the button with left arrow. Button with double left arrow removes all items from 

the check list. Colors of lines resemble colors of the carrier wave functions. Blue lines show 

total emission spectrum and total contributions of an individual QWs (all subbands together), 

while red, green, and orange lines shows contributions of heavy, light, and split-off holes, 

respectively. 

Save button allows to save these data in ASCII format (the same effect has ‘Export-

>Detailed Spectrum’ menu item in the main window). 

 
Fig. 16. Detailed Spectrum window. 

 

4.3.5 Optical Confinement Factors 

This window shows the optical confinement factors for each mode and each quantum well. 

The column Total shows the sum over the quantum wells. The user can sort modes using 

the following Sort By menu items: 

� Mode Index (First TE) – modes are sorted by their index, TE modes go first. 

� Mode Index (First TM) – modes are sorted by their index, TM modes go first. 

� Value – the modes are sorted by the value of total optical confinement factor in the 

descending order. This option allows reveal the mode which is most favorable for 
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laser generation, i.e. having larger optical gain and, therefore, lower threshold 

current. 

 

 

Fig. 17. Optical Confinement Factors window. 

 

4.3.6 Laser Characteristics 

The Laser Characteristics window presents the laser characteristics. The first tab includes a 

table with the following columns: 

� Bias (V) 

� Output optical power (W) 

� Current (A) 

� Current density (A/cm2) 

� Radiative current density (A/cm2) 

� Optical gain (1/cm) 

� Total optical loss (1/cm) 

� Optical loss because of the free carrier absorption in the quantum wells (1/cm) 

� Optical loss because of the free carrier absorption outside the quantum wells (1/cm) 

� Wavelength of the gain spectrum maximum (nm) 

 



 
 

 

    

SiLENSe User Manual 29 of 36 

 

 
Fig. 18a. Laser Characteristics window : Table. 

 

The second tab shows the power-current characteristics as well as the threshold current and the 

differential quantum efficiency. 

 

 Fig. 18b. Laser Characteristics window : Power-Current characteristics. 

 

The third tab shows variation of the optical gain and loss with the current density. 
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Fig. 18c. Laser Characteristics window : Optical Gain and Loss. 

 

The fourth tab shows variation of the gain spectrum maximum with the current density. 

 

Fig. 18d. Laser Characteristics window : Wavelength. 

 

4.4 Exploring Plots 

All the graphs in SiLENSe support the following operations:  

� Zoom in:  select the region of interest from the upper left to the right down keeping 

the left mouse button pressed. The zoomed region will appear in the plot window.  
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� Zoom out:  select any region in the plot area from the right down to the left upper 

keeping the left mouse button pressed. This action returns a plot to the full-size 

mode.  

� Scrolling:  drug the plot inside the plot area keeping the right mouse button pressed. 

Then the adjacent region of the plot will be displayed. 

NB  Save current chart menu item allows the user to save current chart as a graphic file. 

 

5 Output Files 

The simulation results can be stored either as plain text data files or as ASCII TecPlot® files 

(*.plt), which allows visualization within the graphic software package Tecplot®. Anyway, 

the data are stored in columns separated by tab and the difference is in the headers only. 

5.1 Band Diagram, Carrier Concentrations, Recombination Rate etc. 

The Export | Current result menu item in the List of Results window enables one to export 

the results of main drift-diffusion solver. The following variables are stored in columns 

separated by tab: 

� Position (nm) 

� Conduction band, valence band, quantum potential for electrons and holes, electron 

Fermi level, hole Fermi level (eV) 

� Electric potential (V) and electric field (MV/cm) 

� Electron and hole current densities (A/cm2) 

� Concentration of electrons, holes, ionized donors and acceptors (cm-3) 

� Radiative recombination, total non-radiative recombination, Shockley-Read-Hall 

recombination, and Auger recombination (cm-3 s-1) 

� Spontaneous, piezoelectric, and total polarization (C/m2) 

� Four strain components: xxε , yyε , zzε , and yzε  

� Non-radiative carrier lifetimes due to dislocations and point defects 

The Export | All Results in Single File menu item provides export of the same data for all the 

computed results. In this case, a column containing the p-n junction bias is inserted into first 

position. 
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5.2 I-V Characteristics 

The Export I-V characteristics button in the List of Results window enables one to export the 

I-V characteristic and related values. The following variables are stored in columns 

separated by tab: 

� Bias (V) 

� Current density (A/cm2) 

� Internal quantum efficiency 

� IQE computed taking into account recombination in QWs only  

� Injection efficiency 

� Peak emission wavelength (nm) 

� Non-ideality factor 

� Voltage (V) 

� Current (A) 

� Radiative current density (A/cm2) 

� Non-radiative current density (A/cm2) 

� Current density of Shockley-Read-Hall recombination (A/cm2) 

� Current density of Auger recombination (A/cm2) 

� Injected electron current density (A/cm2) 

� Injected hole current density (A/cm2) 

� Electron current density at p-type boundary (A/cm2) 

� Hole current density at n-type boundary (A/cm2) 

5.3 Carrier Wave Functions 

The Export | Carrier Wave Functions menu item enables one to export the carrier wave 

functions. The output file contains the following variables stored in columns separated by 

tab: 

� Position (nm) 

� Conduction band, valence band, electron Fermi level, hole Fermi level (eV) 

� QW indicator which equals to 1 if the point belongs to one of QWs and 0 otherwise 

� Carrier wave functions (nm1/2)  

 

Wave functions are named as follows:  

QW<QW index><carrier type><level index>,  
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where letters EE, HH, LH, and SH denotes electrons, heavy holes, light holes, and split-off 

holes, respectively. 

5.4 Emission Spectra 

The Export | Emission Spectra menu item enables one to export the emission spectra. The 

output file contains the following variables stored in columns separated by tab: 

� Energy (eV) 

� ETotal (cm-2 s-1 eV-1) – total emission intensity 

� EQW1 (cm-2 s-1 eV-1) – emission intensity from the 1-st QW 

� EQW2 (cm-2 s-1 eV-1) – emission intensity from the 2-nd QW 

� …… 

� EQWN (cm-2 s-1 eV-1) – emission intensity from the last QW 

 

The following data are the same intensities normalized to the wavelength 

� Wavelength (nm) 

� WTotal (cm-2 s-1 nm-1) – total emission intensity 

� WQW1 (cm-2 s-1 nm-1) – emission intensity from the 1-st QW 

� WQW2 (cm-2 s-1 nm-1) – emission intensity from the 2-nd QW 

� … 

� WQWN (cm-2 s-1 nm-1) – emission intensity from the last QW 

 

Warning:  One should plot the data form the first group vs the energy, and from the second 

group vs the wavelength in order to keep the right normalization of the intensity to the total 

recombination rate! 

5.5 Gain Spectra 

The Export | Gain Spectra menu item enables one to export the gain spectra. The output file 

contains the following variables stored in columns separated by tab: 

� Energy (eV) 

� ETotal (cm-1) – sum of the following columns 

� EQW1 (cm-1) – gain in the 1-st QW 

� EQW2 (cm-2 s-1 eV-1) – gain in the 2-nd QW 

� …… 

� EQWN (cm-2 s-1 eV-1) – gain in the last QW 

� Wavelength (nm) 



 
 

 

    

SiLENSe User Manual 34 of 36 

 

5.6 Overlap Integrals 

The Export | Overlap integral menu item enables one to export the overlap integrals. The 

output is a text file. The data are arranged similarly to their appearance in the Overlap 

Integrals window (Sec. 4.3.3). 

5.7 Waveguide Modes 

The Export | Waveguide Modes menu item enables one to export the gain spectra. The 

output file contains the following variables stored in columns separated by tab: 

� Position (nm) 

� Refractive index for ordinary wave 

� Refractive index for ordinary wave modified – see details in [3]. 

� Refractive index for extraordinary wave modified 

� Refractive index for extraordinary wave modified – see details in [3]. 

� FieldTE1 (cm-1) – squared electric field for the 1-st TE mode 

� FieldTE2 (cm-1) – squared electric field for the 2-nd TE mode 

� …… 

� FieldTEN (cm-1) – squared electric field for the last TE mode 

� FieldTM1 (cm-1) – squared electric field for the 1-st TM mode 

� FieldTM2 (cm-1) – squared electric field for the 2-nd TM mode 

� …… 

� FieldTMN (cm-1) – squared electric field for the last TM mode 

5.8 Laser Characteristics 

The Export | Laser Characteristics menu item enables one to export the laser characteristics. 

The data are arranged similarly to their appearance in the Table tab of the Laser 

Characteristics window (Sec. 4.3.6). 

6 Solver Parameters 

The section describes the solver parameters in the Global parameters tab window.  

6.1 Main Solver Parameters  

The grid is generated automatically using only the Intervals per layer parameter. First, the 

basic grid step h is calculated as L / Intervals , where L is the typical layer length. Then for all 
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layers the grid step in the central part of the layer equals to h. Near the layer boundaries, the 

step decreases down to 0.01 nm.  

 

The computations are terminated if the iteration number exceeds the value of the Maximum 

number of iterations parameter. 

 

The Potential solver parameter and Fermi levels solver parameter are used by developers to 

study the code performance and for further optimization. In regular version, they are shown 

in read-only mode. 

6.2 Spectrum Solver Parameters  

The spectrum solver generates a separate uniform mesh for each quantum well to solve the 

Schrödinger equation. The user should specify the Mesh step in the respective text field. The 

recommended mesh step is about 0.05-0.2 nm. Effective LAPACK computational routines [4] 

are used to solve the eigenvalue problem. 

 

The Minimum energy level and Wavefunction damping in a barrier parameters are used for 

determination of the computational domain boundaries for each quantum well, as described 

in Sec. 8.2 of [3]. They are rarely needed to be modified. Generally, quantum wells with the 

barrier heights smaller than the value of the former parameter are ignored in the spectrum 

calculation. The last parameter determines the minimum damping of the wave function at the 

domain boundaries. The higher this parameter, the wider barrier regions are included in the 

domain. 

 

The Maximum number of levels in a QW parameter is introduced to limit the maximum 

amount of the heap memory and computation time needed for the solution of the 

Schrödinger equation. If there are more levels exists in the quantum well, only first several 

levels will be calculated according to the maximum number.  

 

The Spectrum broadening parameter determines the width γ  used to calculate the spectrum 

broadening as discussed in Sec. 8 of [3]. 
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